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Preface
Purpose of the document

This user guide provides information about Watch Banking Analytics Premium. The information
includes how to get started with the product and how to use the menus.

Audience

This document is for SWIFT customers that have subscribed to Watch Banking Analytics Premium.

This includes the following audience:

• end users
• user administrators
• back-up administrators

Related documentation

• Watch Banking Analytics Premium Service Description
• Knowledge Base - Search: Watch
• Watch Banking Analytics Premium Tutorial
• Standards MT
• SWIFT Glossary
• SWIFT Advanced Support and Care Services Service Description
• SWIFT Community Support Service Description
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Significant Changes
This section lists the main changes since the previous publication of the document. It does not
include general edits or minor updates.

Updated information Location

Updates to the user interface Watch Analytics Homepage on page 8

Watch Banking Analytics Premium Wizard
dimensions

Watch Banking Analytics Premium Wizard
Dimensions on page 17

Watch Banking Analytics Premium 
User Guide

Significant Changes

30 November 2020 4



1 Introduction
About Watch Banking Analytics Premium

Watch Banking Analytics Premium is an online analysis product that provides an aggregated
overview of an institution's FIN traffic and an aggregated overview of some targeted payload
information from FIN messages (like amount, currency, and other data attributes as defined in List
of New Aggregated Payload Information Compared to Watch Banking Analytics on page 59)
information, focusing on payments, trade finance, and treasury messages.

Customers can use this product to examine their SWIFT messaging in an interactive and intuitive
way and, by comparing them with SWIFT totals, to deduct some useful insights for their business.

Purpose of Watch Banking Analytics Premium

Watch Banking Analytics Premium is designed to provide customers with insights on their own FIN
traffic flows and overall SWIFT FIN traffic flows, in order to enable customers to:

• identify business opportunities at different market levels
• benchmark their performance against overall SWIFT FIN traffic
• monitor counterparty relationships
• stimulate innovation by prompting the development of new products, services, and strategies,

and measuring their effectiveness
• improve operational efficiency of both existing and newly developed services
• optimise their correspondent network
• increase and track their sales performance
• improve competitive analysis by ranking their activities compared to peers
• monitor their gpi adoption on a daily basis per currency, country, and counterparty country
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2 Access Watch Banking Analytics Premium

2.1 Prerequisites

2.1.1 System Requirements
Web browser requirements

Watch Banking Analytics Premium has been qualified against the English language version of the
following certified Web browsers:

• Microsoft Internet Explorer
• Firefox
• Google Chrome

Memory requirements

SWIFT certification has been done using an Intel i7 CPU 2.9Ghz, 8Gb RAM with Windows 7 and
Google Chrome.

For optimal performance, use a similar configuration. A minimum of 4 GB of RAM is recommended.

Connection requirements

Due to the amount of data usually transferred during Watch sessions, users must have a fast
throughput internet connection (2Mbps as a minimum). It is also strongly advised to work with an
Internet Service Provider that has a high bandwidth backbone connection to Europe.

Other requirements

Watch reports can be provided in XLS, XLSX, HTML, CSV, PDF, or TEXT format. To open XLS or
XLSX reports, Microsoft Excel 2007 or Microsoft 2002 (with an additional software patch supporting
backward compatibility) is required.

A number of Watch visuals are provided in Flash. Flash requires a plug-in installed in your browser.
A lighter version of these Flash views can be obtained in HTML when Flash is not an option. This
mode is called interactive mode and is available in the Views menu.

Note SWIFT plans to replace Flash-based visuals with HTML-based ones. When this
change happens, the interactive mode will no longer be available. It will be replaced
by a presentation mode instead.

2.1.2 Customer Log in and Subscription to Watch Products
To access the Watch products web page you need:

• A customer log in.

If you do not have one, then you can register on www.swift.com.
• A subscription to Watch products. For more information, refer to your institution administrator.

Related information

Knowledge base tip 2106959
Knowledge base tip 5019924
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2.2 Log in
Before you begin

See System Requirements on page 6 and Customer Log in and Subscription to Watch Products on
page 6.

Procedure

1. Go to www.swift.com > Our solutions > Compliance and Shared Services > Business
Intelligence.

2. Click Log in to Watch .
3. Enter your e-mail address and password and click Sign in .

2.3 Time-out
When there is no activity during 30 minutes on the platform, a time-out takes place.

2.4 Log Out
Procedure

1. From the shared report (or my institution shared report) page, click your name on the top
right corner of the page.

2. Select Logout.
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3 Watch Banking Analytics Premium
Environment

3.1 Project Landing Page
The project landing page appears after a successful log on to Watch. This page contains all your
Watch product subscriptions.

3.2 Watch Analytics Homepage
The Watch Analytics homepage appears after a successful log on to Watch Analytics. It will help
you navigate through the different wizards and visual dashboards that are available in the
application.

The Watch Analytics homepage includes links to:

• Data playground (wizards) available in Traffic, Banking, and Banking Analytics Premium
• Data visualisations (pre-defined visual dashboards)
• Shared folder
• Data Highlights
• Help page
• About us page
• Billing Analytics
• Message Cost Analytics
• Admin Configuration
• What's new

Tip To go back to the folder view, click Go back to folder view.
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3.2.1 Data Playground (Wizards)
Content

The content available in the Data playground is based on your subscription.

For the Banking Analytics Premium subscription, the following is available:

• Traffic, Banking, and Banking Analytics Premium wizards
• Ranking reports

Wizards

A wizard is an entry form or a prompt page. It enables you to easily query your data and create
reports and templates. The Wizard can always stay attached to your template or simply removed
when you save it.

The following wizards are available in Watch Banking Analytics Premium and are accessible to
Banking Analytics Premium customers:

• Traffic Analytics

FIN Traffic Wizard

FileAct Traffic Wizard

InterAct Traffic Wizard
• Banking Analytics

FIN Value wizard

FIN FX Value wizard
• Banking Analytics Premium

Payments wizard

Trade Finance wizard

Treasury wizard

In Banking Analytics Premium, each wizard focuses on a specific message type (MT) scope for
easier analysis.

Ranking reports

The ranking reports contain several reports to analyse your ranking in different areas.

The available ranking reports are:

• Global ranking
• Ranking per geo-region
• Ranking per country
• Ranking per country at group level
• Ranking per market
• Ranking per message type
• Ranking per country per market
• Ranking per country per message type
• Ranking per country per currency
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Related information

For more information about how to use:

• the wizard, see Use the Watch Banking Analytics Premium Wizards on page 16
• the reports, see Use the Watch Banking Analytics Premium Reports on page 46

3.2.2 Data Visualisation
Introduction

The content available in the Data visualisation section is based on your subscription.

For the Banking Analytics Premium subscription, the visual dashboards related to the below topics
are available:

• Payments (including executive reports, currency correlation dossier, and daily traffic dossier)
• Trade Finance (including executive reports and daily traffic dossier)
• Treasury (including daily traffic dossier)
• Rankings

These reports and visuals templates are read-only templates. If you edit a template and want to
keep your changes for future reference, then you must save the template into your Shared Folder.

3.2.3 Data Highlights
Introduction

This section enables you to run interactive dossiers to gain immediate insights from new Watch
features and stay updated with the latest market trends.

3.2.4 Shared Folder
Overview

Shared Folder is available together with the products that your institution has subscribed to. Any
member of your institution can access it. To access it, click the link available in the Watch
Analytics Homepage. The folder view then displays. Open the Shared Folder.

Shared Folder provides the following possibilities:

• View templates that you have created by running the Wizard and saved into the My institution
Analyses folder.

• View templates that you have copied from the Data Visualisations and saved into My
institution Analyses.

• Access the Services folder where you can view report templates created by SWIFT in the
scope of a service assignment.

Note You do not have a write access to the content of Shared Folder. However, you can
update or modify the content of its sub-folder My Institution Analyses.
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3.2.5 Help Page
Documentation

This page contains the documentation related to your product. This documentation is updated
when required.

The following documentation is available:

• Service Descriptions
• User Guides
• Frequently Asked Questions
• How to video's
• Getting started on Watch
• How to use visual dashboards
• Watch Administration Guide
• MicroStrategy 2020 Navigation Guide

Contact us

This page provides you all contact details in case you have questions.

Content of the page:

• How to contact Customer Support
• How to provide feedback to the Watch product management team
• How to reach your regional contacts

3.2.6 About Us Page
This routes you to information about all our products and services and links to www.swift.com.

3.3 SWIFT Logo Menu
The following menus are available under the SWIFT Logo:

• Projects
• Home
• Shared Reports
• History List
• My Subscriptions
• Logout

3.3.1 Projects
This menu enables you to view and access all the projects that you have subscribed to.
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3.3.2 Home
The Home menu takes you back to the Shared Reports page.

This is the main folder when you enter Watch Banking Analytics Premium. It is the landing page
containing your subscribed products, documentation, and institution shared folder.

3.3.3 Shared Reports
The Shared Reports page appears after a successful log on to Watch Banking Analytics Premium.
It contains the products that you have subscribed to, documentation, Library of Views, and My
Institution Shared Folder.

3.3.4 History List
Introduction

The History List enables you to access report results that you have added. You can add a report
to the History List while it is still running, which enables you to work on other tasks. You can also
add a report to the History List because you want to view its results at a later stage. The results of
the report remain available in this list. You can access these results without running the report
again.

Note The history list size has been limited to 50 elements. This is subject to change.

Related information

For more information about how to use the History List see :

• Save a Report in the History List on page 51
• Add a SWIFT Template Report or a Visual to the History List on page 58
• View a Saved Report in the History List on page 52

3.4 Watch Banking Analytics Premium Workspace
Overview

The Watch Banking Analytics Premium workspace is available after running any of the following
wizards: Payments, Trade Finance, Treasury, or when accessing a ranking report or a report
template. From here, you can edit or customise your report.
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Example

Components

The menu
bar

The Menu bar enables you to access different menus. The menus are also
available as toolbar icons.

The icons
toolbar

The menu bar and the toolbar icons contain the same functions. A brief explanation
of the use of each icon is available by just hovering with the cursor.

Icon How to use it

Grid

Graph

Grid and Graph

Change the View of a Report on page 46

Re-prompt Add or Remove Criteria in the Wizard on
page 16

Add to History List Save a Report in the History List on page
51 Run a Report while Using other
Functions on page 52
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Icon How to use it

Show or hide data values in a graph Show or Hide Data Values in a Graph on
page 54

Export Export a Report on page 52

Export PDF Export a Report to PDF Only on page 52

Rename Edit Objects Rename Attributes in a Grid on page 47

Merge Columns Headers

Merge Row Headers

Merge Columns or Rows in a Grid on page
56

Layout Display the Grid with Different Font, Colour,
and Shape on page 55

Banding Show Banding in a Grid on page 55

Report details Display the Report Details on page 51

Report objects View Report Objects on page 46

Page-by Axis Use the View Filter Option in a Grid on page
55
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Icon How to use it

Prompt Details Display the Prompt Details on page 51

View Filter Add a Filter to a Report on page 48

Drill Drill on Existing Attributes on page 49

Swap Rows and Columns Swap Rows and Columns in a Grid on page
55

Show Totals

Edit Totals

Show Totals on page 48

Edit Totals on page 48

Lock Column Headers

Lock Row Headers

Lock Column or Row Headers in a Grid on
page 55

The main
area

The main area can display a grid and, or a report for instance. What you see in this
area is always specific to your selection.

The Report
Objects

The Report Objects displays the attributes of your Wizard selection. It also shows
the selected metrics.

Tip The first time that you run a report, the Report Objects is not
displayed, you can open it from the Tools menu.

Watch Banking Analytics Premium 
User Guide

Watch Banking Analytics Premium Environment

30 November 2020 15



4 Use Watch Banking Analytics Premium
This chapter explains the main procedures that you can perform in Watch Banking Analytics
Premium. The procedures are explained using the menu options (except when it cannot be used
for a specific procedure). For most procedures, however, the menu icons, the right-click option, or
both can also be used. You can find the list of most common icons in Watch Banking Analytics
Premium Workspace on page 12.

4.1 Use the Watch Banking Analytics Premium
Wizards

4.1.1 Generate a Report with a Wizard
Procedure

1. From the Watch Banking Analytics Premium page, click the relevant wizard or select a ranking
report.

2. From the Index panel, select the attributes and metrics as required. Some of them are
required.

Definitions of the available attributes and metrics are available in Watch Banking Analytics
Premium Wizard Dimensions on page 17.

Note Some selections are already filled like Message Type in the attributes section.
You can easily remove these selections by double-clicking on the attribute name
and replace it by other attributes.

Tip You can view a summary of your selections by clicking Summary of your
selections.

3. Check the Remember this answer checkbox if you want the Wizard to remember your criteria
until the next time that you open it.

4. Click Run report .

4.1.2 Add or Remove Criteria in the Wizard
About this task

Once the output of the Wizard is on screen, you may realise that the output does not match the
information that you need.
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Procedure

1. From the Data menu, select Re-prompt.
2. Add or remove criteria as required.
3. Click Run Report .

4.1.3 Watch Banking Analytics Premium Wizard Dimensions
Introduction

This section provides definitions of the FIN attributes and metrics available in Watch Banking
Analytics Premium.

Attributes
Attributes available in all wizards (Payments, Trade Finance, and Treasury)

Attribute Definition

BIC8 This attribute includes all your institution's branches'
BIC8s.

Format: XXXXXXXX - Branch Name

Example: DEMOFRPP - My French Branch

BIC8 Segment Your own BIC8 segment (created by your Watch
Admin). This will help you to customise templates
and reports even further.

Example: Type of business: Bank, Size of Institution:
Key Client

BIC8 Segmentation Your own BIC8 segmentation (created by your Watch
Admin). This will help you to customise templates
and reports even further.

Example: Type of business, Size of Institution

BIC11 This attribute includes all your institution's branches
BIC11s.

Format: XXXXXXXXXXX - Branch Code

Example: DEMOFRPPXXX - French Branch Code

Business Area This attribute includes the different business areas of
the traffic you exchange.

Format: Business area name

Example: Customer Credit Transfers

Category This attribute includes all the different FIN message
categories information.

Format: X - Category name

Example: 1 - Customer Payments and Cheques
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Attribute Definition

Copied/Non-copied Not copied is used when no FIN copy service is
available.

Copy service The copy services and their description.

Counterparty BIC8 This attribute includes all your counterparty's
branches' BIC8s.

Format: XXXXXXXX - Branch Name

Example: DEMOFRPP - My French Branch

Counterparty BIC8 Segment Your own Counterparty BIC8 segment (created by
your Watch Admin). This will help you to customise
templates and reports even further.

Example: Type of business: Bank, Size of Institution:
Key Client

Counterparty BIC8 Segmentation Your own Counterparty BIC8 segmentation (to be)
created by your Watch Admin. This will help you to
customise templates and reports even further.

Example: Type of business, Size of Institution

Counterparty BIC11 This attribute includes all your counterparty's
branches' BIC11s.

Format: XXXXXXXXXXX

Example: DEMOFRPPXXX

Counterparty Country This attribute includes the countries where your
counterparty has branches.

Format: Country name

Example: France

Counterparty Geo Region This attribute includes the geographical regions
where your counterparty has branches.

Format: geo region name

Example: Middle East

Counterparty Group Country This attribute includes the country where your
counterparty group BIC is located.

Counterparty Group Geo Region This attribute includes the geographical region where
your Counterparty Group BIC is located.

Counterparty Group Primary BIC This attribute displays the parent BIC of the
Counterparty Group.

Format: XXXXXXXX

Example: DEMOXX01

Counterparty Role This attribute identifies the role of your counterparty.
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Attribute Definition

Country This attribute includes the countries where your
institution has branches.

Format: Country name

Example: France

Currency This attribute includes all the currencies in which
traffic can be exchanged.

Format: XXX

Example: EUR

Customer Route This attribute provides you with information on the
distribution of traffic.

Traffic can be either of the following:

• Intra-customer-group (that is, traffic exchanged
within the same institution group of branches)

• Inter-customer-group (that is, traffic exchanged
between different institutions, excluding all traffic
exchanged within a same institution's branches)

• SWIFT (that is, traffic exchanged with SWIFT
BICs)

Delivery Status This attribute provides you with information on the
delivery status of your traffic. The possible values of
this attribute are Delivered, Aborted, Naked,
Refused by Infrastructure.

Geo Region This attribute includes the geographical regions
where your institution has branches.

Format: Geo region name

Example: Middle East

Geo Route This attribute provides you with information on the
geographical distribution of traffic.

The geo route can be either of the following:

• Domestic (that is, traffic exchanged between
institutions located in the same country)

• International (that is, traffic exchanged between
institutions located in different countries)

• SWIFT (that is, traffic exchanged with SWIFT
BICs)

Message Type This attribute includes all the different message types
contained in the product you are accessing.

Format: MT XXX

Example: MT 103+
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Attribute Definition

Month This attribute includes the different months for which
you can extract data.

Format: Mmm

Example: Jan

My Role This attribute identifies the role of your institution.

Period This attribute includes the different months for which
you can extract data.

Format: MONYYYY

Example: NOV2014

Quarterly period This attribute includes the different quarters for which
you can extract data.

Format: QXYYYY

Example: Q22014

Standard Value Bucket EUR This attribute provides you with the number of
transactions with a value in each of the following
buckets in EUR:

• 0 to < 500

• 500 to < 2,500

• 2,500 to < 10K

• 10K to < 25K

• 25K to < 50K

• 50K to < 100K

• 100K to < 500K

• 500K to < 1M

• 1M to < 10M

• 10M to < 50M

• 50M and greater
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Attribute Definition

Standard Value Bucket USD This attribute provides you with the number of
transactions with a value in each of the following
buckets in USD:

• 0 to < 500

• 500 to < 2,500

• 2,500 to < 10K

• 10K to < 25K

• 25K to < 50K

• 50K to < 100K

• 100K to < 500K

• 500K to < 1M

• 1M to < 10M

• 10M to < 50M

• 50M and greater

Test Environment flag (Y/N) This attribute provides you with a distinction
possibility between your test traffic Y and live traffic
N.

Year This attribute includes the different available years of
traffic (maximum 3 years of data).

Format: YYYY

Example: 2014

Additional attributes are available in the Payments wizard

Attribute Definition

Account Servicing Institution BIC8 The institution - when other than the Receiver - which
services the account of the account owner to be
debited.

Available if Option A is used in field 52A in MT 101.

Account Servicing Institution Clearing System The National Clearing System used in Option A or C,
field 52A.

Available for MT 101.

Account Servicing Institution Clearing System
Flag

Identifies if a National Clearing System is used in
Option A or C, field 52A.

Available for MT 101.

Account Servicing Option Information about the usage of field 52A in MT 101.

This can be either of the following: Option A, Option
C, Empty field.
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Attribute Definition

Account With Institution BIC8 The financial institution which services the account
for the beneficiary customer.

Available if Option A is used in field 57A in MT 101.

Account with Institution Clearing System The National Clearing System used in Option A, C, or
D, field 57A.

Available for MT 101.

Account with Institution Clearing System Flag Identifies if a National Clearing System is used in
Option A, C, or D, field 57A.

Available for MT 101.

Account With Institution Option Information about the usage of field 57A in MT 101.
This can be either of the following: Option A, Option
C, Option D, Empty field.

Charge Detail This attributes identifies who bears the charges of the
payment (field 71A, mandatory field).

The charge detail can be either of the following:

• Beneficiary

• Our customer charged

• Shared charges

Available for MT 103, MT 103 REMIT, and MT 103+.

Corrected Initial Ordering BIC8 This attribute provides you the BIC8 of the bank of
the originator of a payment.

Available if Option A is used in field 52A in MT 103,
MT 103 REMIT, MT 103+, MT 202, MT 202 COV, MT
205, and MT 205 COV.

Field 52A is optional. If the field is empty, this
attribute provides you the BIC8 of the bank that sent
the payment.

The data is available as from April 2015.

Corrected Initial Ordering Country This attribute provides you the country of the bank in
which a payment is originated.

Available if Option A is used: all countries identified
by the country codes in the BIC8 code in field 52A in
MT 103, MT 103 REMIT, MT 103+, MT 202, MT 202
COV, MT 205, and MT 205 COV.

Field 52A is optional. If the field is empty, this
attribute provides you the country of the bank that
sent the payment.
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Attribute Definition

Corrected Initial Ordering Geo Region This attribute provides you the geo region of the bank
in which a payment is originated.

Available if Option A is used: all geo regions linked to
the country codes in the BIC8 code in field 52A in MT
103, MT 103 REMIT, MT 103+, MT 202, MT 202
COV, MT 205, and MT 205 COV.

Field 52A is optional. If the field is empty, this
attribute provides you the geo region linked to the
country of the bank that sent the payment.

Corrected Initial Ordering Group This attribute provides you the parent BIC of the
originator of a payment.

Available if Option A is used in field 52A in MT 103,
MT 103 REMIT, MT 103+, MT 202, MT 202 COV, MT
205, and MT 205 COV. Field 52A is optional.

If the field is empty, this attribute provides you the
parent BIC that sent the payment.

The data is available as from April 2015.

Corrected Ultimate Beneficiary BIC8 This attribute provides you the BIC8 of the bank of
the beneficiary of a payment.

Available if Option A is used in field 57A in MT 103,
MT 103 REMIT, MT 103+, MT 205 and MT 205 COV,
and in 58A in MT 202, MT 202 COV.

Field 57A is optional and field 58A is mandatory. If
field 57A is empty, this attribute provides you the
BIC8 of the bank that received the payment.

The data is available as from April 2015.

Corrected Ultimate Beneficiary Country This attribute provides you the country of the bank of
the ultimate beneficiary of a message.

Available if Option A is used: all countries identified
by the country codes in the BIC8 code in field 57A in
MT 103, MT 103 REMIT, MT 103+, MT 205, and MT
205 COV and in 58A in MT 202 and MT 202 COV.

Field 57A is optional and field 58A is mandatory. If
field 57A is empty, this attribute provides you the
country of the bank that received the payment.

The data for MT 202 and 202 COV is available as
from October 2014.
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Attribute Definition

Corrected Ultimate Beneficiary Geo Region This attribute provides you the geo region of the bank
of the ultimate beneficiary of a message.

Available if Option A is used: all geo regions linked to
the country codes in the BIC8 code in field 57A in MT
103, MT 103 REMIT, MT 103+, MT 205, and MT 205
COV and in 58A in MT 202 and MT 202 COV.

Field 57A is optional and field 58A is mandatory. If
field 57A is empty, this attribute provides you the geo
region linked to the country of the bank that received
the payment.

The data for MT 202 and 202 COV is available as
from October 2014.

Corrected Ultimate Beneficiary Group This attribute provides you the BIC8 of the bank of
the beneficiary of a payment.

Available if Option A is used in field 57A in MT 103,
MT 103 REMIT, MT 103+, MT 205 and MT 205 COV,
and in 58A in MT 202, MT 202 COV.

Field 57A is optional and field 58A is mandatory. If
field 57A is empty, this attribute provides you the
parent BIC that received the payment.

The data is available as from April 2015.

Cover Payment Flag Identifies whether an MT103 message was sent in
the context of payments using the cover method or
not. (based on field 53A in MT 103).

Currency Group This attribute indicates if the FX trade was for a
single currency, a currency pair, same currency, or no
currency.

Currency Pair This attribute shows the combination of instructed
currency (field 33B) and currency (field 32A or 32B).

gpi active BIC8 This attribute identifies whether or not a reported
institution is an active gpi participant and thus able to
send/receive gpi traffic during the reported period for
a reported currency

gpi active counterparty BIC8 This attribute identifies whether or not a
correspondent is an active gpi participant and thus
able to send/receive gpi traffic during the reported
period for a reported currency.

gpi CUG member This attribute identifies whether or not a reported
institution is a gpi CUG member during the reported
period, irrespectively of the currency.

gpi CUG Member Counterparty This attribute identifies whether or not a
correspondent is a gpi CUG member during the
reported period, irrespectively of the currency.

Watch Banking Analytics Premium 
User Guide

Use Watch Banking Analytics Premium

30 November 2020 24



Attribute Definition

gpi Flag This attribute identifies if your payment sent or
received is a SWIFT gpi payment or not. The traffic
can be either of the following:

For MT 103, MT 103R, MT 202C and MT 205C:

If gpi Service Type is 001,

• gpi to gpi - a message sent with service type 001
to gpi member (as of Standard Release
November 2017) if recevier is timely gpi member

non-gpi to gpi - a message sent without service
type to gpi member (as of Standard Release
November 2017) if receiver is timely gpi member

If gpi Service Type is not 001,

• non-gpi to gpi - a message sent without service
type to gpi member (as of Standard Release
November 2017) if receiver is timely gpi member

• non-gpi to non-gpi - a message sent without
service type to non-gpi member (as of Standard
Release November 2017) if receiver is not timely
gpi member

For MT 199, MT 202, MT 205 and MT 299:

If gpi Service Type is 001 or 003,

• gpi to gpi - a message sent with service type 001
to gpi member (as of Standard Release
November 2017)

If gpi Service Type is not 001 or 003,

• non-gpi to non-gpi - a message sent without
service type to non-gpi member (as of Standard
Release November 2017)

For MT 101:

If UETR is present,

• gpi to gpi - a message sent with service type 001
to gpi member (as of Standard Release
November 2017)

If UETR is not present,

• non-gpi to non-gpi - a message sent without
service type to non-gpi member (as of Standard
Release November 2017)

For other message types:

• Not applicable - if used in combination with other
message than specified below

For the definition of gpi members, the currencies
disclosed in the gpi Directory are taken into account.
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Attribute Definition

gpi Service Type A numeric code contained in field 111 of a FIN
message or in the Business Element in API calls that
identifies the gpi service against which the gpi
customer will be measured.

Initial Ordering BIC8 This attribute provides you the BIC8 of the bank of
the originator of a payment.

Available if Option A is used in field 52A in MT 103,
MT 103 REMIT, MT 103+, MT 202, MT 202 COV, MT
205, and MT 205 COV. Field 52A is optional.

The data is available as from April 2015.

Initial Ordering Country This attribute provides you the country of the bank in
which a payment is originated.

Available if Option A is used: all countries identified
by the country codes in the BIC8 code in field 52A in
MT 103, MT 103 REMIT, MT 103+, MT 202, MT 202
COV, MT 205, and MT 205 COV.

Field 52A is optional.

Initial Ordering Geo Region This attribute provides you the geo region of the bank
in which a payment is originated.

Available if Option A is used: all geo regions linked to
the country codes in the BIC8 code in field 52A in MT
103, MT 103 REMIT, MT 103+, MT 202, MT 202
COV, MT 205, and MT 205 COV.

Initial Ordering Group This attribute provides you the parent BIC of the
originator of a payment.

Available if Option A is used in field 52A in MT 103,
MT 103 REMIT, MT 103+, MT 202, MT 202 COV, MT
205, and MT 205 COV. Field 52A is optional.

The data is available as from April 2015.

Initial Ordering Option This attribute provides you information about the
usage of field 52A in MT 103, MT 103 REMIT, MT
103+, MT 202, MT 202 COV, MT 205, and MT 205
COV.

The Initial Ordering Option can be either of the
following:

• Option A (BIC8 existing from which we extract the
Initial Ordering Country)

• Empty field (when field 52A is not completed)

• Free format (or structured in a way we cannot
extract a BIC8 and subsequent country, for
example Option D)

• Not available (non-ISO country codes)
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Attribute Definition

Instructed currency This attribute provides the instructed currency (field
33B, conditional field).

Format: XXX

Example: EUR

Available for MT 103, MT 103 REMIT, and MT 103+.

Instructing Institution BIC8 The instructing bank which instructed the Sender or
previous institution in the transaction chain, to
execute the transaction.

Available if INS is used in field 72 in MT 103.

Instructing Institution Country The country of the instructing bank which instructed
the Sender or previous institution in the transaction
chain, to execute the transaction.

Available if INS is used in field 72 in MT 103.

Instructing Institution Geo Region The geo region of the instructing bank which
instructed the Sender or previous institution in the
transaction chain, to execute the transaction.

Available if INS is used in field 72 in MT 103.

Instructing Institution Group The group of the instructing bank which instructed
the Sender or previous institution in the transaction
chain, to execute the transaction.

Available if INS is used in field 72 in MT 103.

Instruction Code The instruction code available in field 23E in MT 103.

Intermediary Institution The financial institution through which the transaction
must pass to reach the account with institution.

Available if Option A is used in field 56A in MT 103.

Intermediary Institution Option Information about the usage of field 56A in MT 103.
This can be either of the following: Option A, D, Free
format or Empty field.

Message Type Group This enables you to group all MT 103 message types
(MT 103, MT 103+, MT 103R) into a single value and
as such report on all MTs 103 as a whole.

Opening Balance Currency The currency of the opening balance in field 60A
(Option F or M).

Available for MT 940, MT 950.

Opening Balance Option Information about the usage of field 60A in all MT
940, MT 950.

This can be either of the following: Option F or Option
M.
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Attribute Definition

Receiver's Correspondent BIC8 The branch of the Receiver or another financial
institution at which the funds will be made available
to the Receiver.

Available if option A is used in field 54A in MT 103.

Receiver's Correspondent Option Information about the usage of field 54A in MT 103.
This can be either of the following: Option A, D, Free
format or Empty field.

Remittance Information This attribute provides the following remittance
information (field 70, optional field):

• International Payment Instruction

• Invoice

• Reference for Beneficiary

• Reference for Customer

• SEPA Customer Transfer

• Trade Services Utility Transfer

Available for MT 103, MT 103 REMIT, and MT 103+.

Sender to Receiver Information This attribute provides the following sender to
receiver information (field 72, optional field):

• Account with institution

• Instructing institution

• Intermediary institution

• Receiver

Available for MT 103, MT 103 REMIT, and MT 103+.

Sender's Correspondent BIC8 The account or branch of the Sender or another
financial institution through which the Sender will
reimburse the Receiver.

Available if option A is used in field 53A in MT 103.

Sender's Correspondent Option Information about the usage of field 53A in MT 103.
This can be either of the following: Option A, D, Free
format or Empty field.

Ultimate Beneficiary BIC8 This attribute provides you the BIC8 of the bank of
the beneficiary of a payment.

Available if Option A is used in field 57A in MT 103,
MT 103 REMIT, MT 103+, MT 205 and MT 205 COV,
and in 58A in MT 202, MT 202 COV.

Field 57A is optional and field 58A is mandatory.

The data is available as from April 2015.
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Attribute Definition

Ultimate Beneficiary Country This attribute provides you the country of the bank of
the ultimate beneficiary of a message.

Available if Option A is used: all countries identified
by the country codes in the BIC8 code in field 57A in
MT 103, MT 103 REMIT, MT 103+, MT 205, and MT
205 COV and in 58A in MT 202 and MT 202 COV.

Field 57A is optional and field 58A is mandatory.

The data for MT 202 and 202 COV is available as
from October 2014.

Ultimate Beneficiary Geo Region This attribute provides you the geo region of the bank
of the ultimate beneficiary of a message.

Available if Option A is used: all geo regions linked to
the country codes in the BIC8 code in field 57A in MT
103, MT 103 REMIT, MT 103+, MT 205, and MT 205
COV and in 58A in MT 202 and MT 202 COV.

The data for MT 202 and 202 COV is available as
from October 2014.

Ultimate Beneficiary Group This attribute provides you the parent BIC of the
beneficiary of a payment.

Available if Option A is used in field 57A in MT 103,
MT 103 REMIT, MT 103+, MT 205 and MT 205 COV,
and in 58A in MT 202, MT 202 COV.

Field 57A is optional and field 58A is mandatory.

The data is available as from April 2015.

Ultimate Beneficiary Option This attribute provides information about the usage of
field 57A in MT 103, MT 103 REMIT, MT 103+, MT
205, and MT 205 COV and in 58A in MT 202 and MT
202 COV.

The Ultimate Beneficiary Option is either of the
following:

• Option A (BIC8 existing from which we extract the
Initial Ordering Country)

• Empty field (when field 57A/58A is not completed)

• Free format (or structured in a way we cannot
extract a BIC8 and subsequent country, for
example, Option D)

• Not available (non-ISO country codes)
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Additional attributes available in the Trade Finance wizard

Attribute Definition

Account with Bank BIC8 This attribute identifies the bank, if different from the
Receiver, at which the Receiver is requested to remit
the total amount claimed, in favour of the Sender of
this message, or its branch or affiliate bank. Available
if field 57A is used.

Available for MT 742.

Account with Bank Country This attribute identifies the country of the bank, if
different from the Receiver, at which the Receiver is
requested to remit the total amount claimed, in favour
of the Sender of this message, or its branch or
affiliate bank. Available if field 57A is used.

Available for MT 742.

Account with Bank Geo Region This attribute identifies the geo region of the bank, if
different from the Receiver, at which the Receiver is
requested to remit the total amount claimed, in favour
of the Sender of this message, or its branch or
affiliate bank. Available if field 57A is used.

Available for MT 742.

Account with Bank Group This attribute identifies the institution of the bank, if
different from the Receiver, at which the Receiver is
requested to remit the total amount claimed, in favour
of the Sender of this message, or its branch or
affiliate bank. Available if field 57A is used.

Available for MT 742.

Account with Bank Option This attribute provides information about the usage of
field 57A in MT 742. The Account with bank Option is
either of the following:

• Option A (BIC8 existing from which we extract the

• Account with Bank BIC8)

• Empty field (when field 57A is not completed)

• Free format (or structured in a way we cannot

extract a BIC8 and subsequent country, for
example, Option D)

• Not available (non-ISO country codes)

Available for MT 742.

Advice through Bank BIC8 This attribute identifies the bank, if different from the
Receiver, through which the documentary credit is to
be advised/confirmed to the beneficiary. Available if
option A or D is used in field 57A.

Available for MT 700.
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Attribute Definition

Advice through Bank Country This attribute identifies the country of the bank, if
different from the Receiver, through which the
documentary credit is to be advised/confirmed to the
beneficiary. Available if option A or D is used in field
57A.

Available for MT 700.

Advice through Bank Geo Region This attribute identifies the geo region of the bank, if
different from the Receiver, through which the
documentary credit is to be advised/confirmed to the
beneficiary. Available if option A or D is used in field
57A.

Available for MT 700.

Advice through Bank Group This attribute identifies the institution of the bank, if
different from the Receiver, through which the
documentary credit is to be advised/confirmed to the
beneficiary. Available if option A or D is used in field
57A.

Available for MT 700.

Advice through Bank Option This attribute provides information about the usage of
field 57A in MT 700. The Advice through bank Option
is either of the following:

• Option A (BIC8 existing from which we extract the
Advice through bank BIC8)

• Empty field (when field 57A is not completed)

• Free format (or structured in a way we cannot
extract a BIC8 and subsequent country, for
example, Option D)

• Not available (non-ISO country codes)

Available for MT 700.

Applicant Bank BIC8 This attribute identifies the bank of the applicant
customer, if different from the issuing bank. (field
51A).

Available for MT 700, MT 710.

Applicant Bank Country This attribute identifies the country of the bank of the
applicant customer, if different from the issuing bank
(field 51A).

Available for MT 700.

Applicant Bank Geo Region This attribute identifies the geo region of the bank of
the applicant customer, if different from the issuing
bank (field 51A).

Available for MT 700.

Watch Banking Analytics Premium 
User Guide

Use Watch Banking Analytics Premium

30 November 2020 31



Attribute Definition

Applicant Bank Group This attribute identifies the parent BIC of the bank of
the applicant customer, if different from the issuing
bank. (field 51A).

Available for MT 700.

Applicant Bank Option This attribute provides information about the usage of
field 51A in MT 700, MT 710. The Applicant Bank
Option is either of the following:

• Option A (BIC8 existing from which we extract the
Applicant Bank BIC8)

• Empty field (when field 51A is not completed)

• Free format (or structured in a way we cannot

extract a BIC8 and subsequent country, for
example, Option D)

• Not available (non-ISO country codes)

Available for MT 700.

Available with BIC8 This attribute identifies the bank with which the credit
is available. Available if option A or D is used in field
41A.

Available for MT 700, MT 710, MT 740.

Available with Country This attribute identifies the country of the bank with
which the credit is available. Available if option A or D
is used in field 41A.

Available for MT 700, MT 710, MT 740.

Available with Geo Region This attribute identifies the geo region of the bank
with which the credit is available. Available if option A
or D is used in field 41A.

Available for MT 700, MT 710, MT 740.

Available with Group This attribute identifies the institution of the bank with
which the credit is available. Available if option A or D
is used in field 41A.

Available for MT 700, MT 710, MT 740.

Available with Option This attribute provides information about the usage of
field 41A in MT 700, MT 710, MT 740. The Available
with Option is either of the following:

• Option A (BIC8 existing from which we extract the
Available with BIC8)

• Empty field (when field 41A is not completed)

• Free format (or structured in a way we cannot
extract a BIC8 and subsequent country, for
example, Option D)

• Not available (non-ISO country codes)

Watch Banking Analytics Premium 
User Guide

Use Watch Banking Analytics Premium

30 November 2020 32



Attribute Definition

Beneficiary Bank BIC8 This attributes identifies the branch or affiliate bank of
the Sender, in favour of which the total amount
claimed is to be transferred. Available if field 58A is
used.

Available for MT 742.

Beneficiary Bank Country This attributes identifies the country of the branch or
affiliate bank of the Sender, in favour of which the
total amount claimed is to be transferred. Available if
field 58A is used.

Available for MT 742.

Beneficiary Bank Geo Region This attributes identifies the geo region of the branch
or affiliate bank of the Sender, in favour of which the
total amount claimed is to be transferred. Available if
field 58A is used.

Available for MT 742.

Beneficiary Bank Group This attributes identifies the institution of the branch
or affiliate bank of the Sender, in favour of which the
total amount claimed is to be transferred. Available if
field 58A is used.

Available for MT 742.

Beneficiary Bank Option This attribute provides information about the usage of
field 58A in MT 742.

The Beneficiary Bank Option is either of the
following:

• Option A (BIC8 existing from which we extract the
Beneficiary Bank BIC8)

• Empty field (when field 58A is not completed)

• Free format (or structured in a way we cannot
extract a BIC8 and subsequent country, for
example, Option D)

• Not available (non-ISO country codes)

Available for MT 742.

Charges This attribute identifies the charges to be borne by
the beneficiary. Available if field 71D is used.

Available for MT 700.
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Attribute Definition

Confirmation Instruction This attribute identifies the confirmation instructions
(field 49, mandatory field).

The confirmation instructions can be either of the
following:

• Confirm (the receiver is requested to confirm the
credit)

• May add (the receiver may add its confirmation to
the credit)

• Without (the receiver is not requested to confirm
the credit)

Available for MT 700, MT 710, MT 720.

Credit Available This attributes identifies when the credit is available
(field 41A, mandatory field).

The credit availability can be either of the following:

• By acceptance

• By deferred payment

• By mixed payments

• By negociation

• By payment

Available for MT 700, MT 710 and MT 740

Credit Type This attribute identifies the type of credit. (field 40A).

Available for MT 700.

Form of Documentary Credit (code) This attribute identifies whether or not the Sender is
adding its confirmation to the credit. (field 40B).

Available for MT 710 and MT 720.

Form of Documentary Credit (type) This attribute identifies the type of credit. (field 40B).

Available for MT 710 and MT 720.

Issuing Bank BIC8 This attribute identifies the bank which has given the
authorisation to reimburse. (field 52A).

Available for MT 710, MT 742.

Issuing Bank Country This attribute identifies the country of the bank which
has given the authorisation to reimburse. (field 52A).

Available for MT 710, MT 742.

Issuing Bank Geo Region This attribute identifies the geo region of the bank
which has given the authorisation to reimburse. (field
52A).

Available for MT 710, MT 742.
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Attribute Definition

Issuing Bank Group This attribute identifies the institution of the bank
which has given the authorisation to reimburse. (field
52A).

Available for MT 710, MT 742.

Issuing Bank Option This attribute provides information about the usage of
field 52A in MT 710 and MT 742.

The Issuing Bank Option is either of the following:

• Option A (BIC8 existing from which we extract the
Issuing Bank BIC8)

• Empty field (when field 52A is not completed)

• Free format (or structured in a way we cannot
extract a BIC8 and subsequent country, for
example, Option D)

• Not available (non-ISO country codes)

Available for MT710, MT 742.

Issuing bank of the original D/C BIC8 This attribute identifies the issuing bank of the
original documentary credit. Available if field 52A is
used.

Available for MT 720.

Issuing bank of the original D/C Country This attribute identifies the country of the issuing
bank of the original documentary credit. Available if
field 52A is used.

Available for MT 720.

Issuing bank of the original D/C Geo Region This attribute identifies the geo region of the issuing
bank of the original documentary credit. Available if
field 52A is used.

Available for MT 720.

Issuing bank of the original D/C Group This attribute identifies the institution of the issuing
bank of the original documentary credit. Available if
field 52A is used.

Available for MT 720.
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Attribute Definition

Issuing bank of the original D/C Option This attribute provides information about the usage of
field 52A in MT 720.

The Issuing Bank of the original D/C Option is either
of the following:

• Option A (BIC8 existing from which we extract the
Issuing Bank of the original D/C BIC8)

• Empty field (when field 52A is not completed)

• Free format (or structured in a way we cannot
extract a BIC8 and subsequent country, for
example, Option D)

• Not available (non-ISO country codes)

Available for MT720.

L/C Duration Bucket This attribute identifies the duration of the letters of
credits (field 31D minus field 31C), split in the
following buckets (in days):

• L/C length 0 - 30

• L/C length 31 - 60

• L/C length 61 - 90

• L/C length 91 - 180

• L/C length 180 - 360

• L/C length 360+

• L/C length negative

Available for MT 700 and MT 707.

Negotiating Bank BIC8 This attribute identifies the drawer of the drafts to be
drawn on the reimbursing bank, when the drawer is
the negotiating bank. Available if field 58A is used.

Available for MT 740.

Negotiating Bank Country This attribute identifies the country of the drawer of
the drafts to be drawn on the reimbursing bank, when
the drawer is the negotiating bank. Available if field
58A is used.

Available for MT 740.

Negotiating Bank Geo Region This attribute identifies the geo region of the drawer
of the drafts to be drawn on the reimbursing bank,
when the drawer is the negotiating bank. Available if
field 58A is used.

Available for MT 740.

Negotiating Bank Group This attribute identifies the institution of the drawer of
the drafts to be drawn on the reimbursing bank, when
the drawer is the negotiating bank. Available if field
58A is used.

Available for MT 740.
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Attribute Definition

Negotiating Bank Option This attribute provides information about the usage of
field 58A in MT 740.

The Negotiating Bank Option is either of the
following:

• Option A (BIC8 existing from which we extract the
Beneficiary Bank BIC8)

• Empty field (when field 58A is not completed)

• Free format (or structured in a way we cannot
extract a BIC8 and subsequent country, for
example, Option D)

• Not available (non-ISO country codes)

Available for MT 740.

Reimbursing Bank's Charges This attribute identifies by which party the
reimbursing bank's charges are to be borne.
Available if field 71A is used.

Available for MT 740.

Additional attributes available in the Treasury wizard

Attribute Definition

Currency Bought This attribute identifies the currency that was bought
in FX transactions (field 32B).

Currency Group This attribute indicates if the FX trade was for a
single currency, a currency pair, same currency, or no
currency.

Currency Pair This attribute shows the combination of instructed
currency (field 33B) and currency (field 32A or 32B).

Currency Sold This attribute provides you with the currency that was
sold in the FX trade (field 33B).

Function This attribute identifies the function of the message
(CANCEL, AMEND, etc.) (field 22A).

Available for MT 300, MT 304, MT 305, MT 306, MT
320.
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Attribute Definition

Instrument Type This attribute identifies the actual FX instrument
confirmed by the MT300 as derived from Fields 22U,
17F, 17O, 22W, 30T, 30V.

The instrument Type can be either of the following:

• FXNDFOO - Foreign Exchange Non Deliverable
Forward Open

• FXNDFOC - Foreign Exchange Non Deliverable
Forward Close

• FXSWAPO - Foreign Exchange SWAP Open

• FXSWAPC - Foreign Exchange SWAP Close

• FXSPOT - Foreign Exchange Spot

• FXFORW - Foreign Exchange Forward

• n/a - Not Applicable

Available for MT 300.

Non-Deliverable Indicator This attribute indicates if the FX trade is a Non-
Deliverable Forward as optionally provided in Field
17F in the MT 300, MT 305.

Available for MT 300 and MT 305.

Non-Deliverable Valuation or Opening Indicator This attribute indicates if the MT300 confirmation is
for Non-Deliverable Forward opening instruction or
closing valuation as provided in Field 17O in the MT
300.

Available for MT 300.

Pay-out Currency This attribute indicates the currency of settlement as
provided in Field 33E in the MT 306

Available for MT 306.

Settlement Country This attribute identifies the country of the settlement
as optionally provided in Field 72 in the MT 300.

Available for MT 300.

Sub-function This attribute identifies the Instrument Type as
provided in field 22U for MT 300 and MT 305, field
94A for MT 304.

Trade Month Specifies the month of the FX trade derived from
Field 30T for MT 300, MT 304.

Format: Mon yyyy

Available for MT 300 and MT 304.

Value Month Specifies the month the FX trade is to be settled as
provided in Field 30V for MT 300, MT 304

Format: Mon yyyy

Available for MT 300 and MT 304.
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Attributes available in all Daily Wizards (Payments, Trade Finance, and Treasury)

Attribute Definition

Daily period This attribute includes the different days for which
you can extract data.

Time zone: UTC.

Format: MMDDYYYY

Example: 7/10/2015

Day This attribute includes the different days for which
you can extract data.

Format: Day

Example: Tue

Additional attributes available in the Treasury Daily wizard

Attribute Definition

Trade Date This attribute specifies the date the FX trade was
made as provided in Field 30T for MT 300, MT 304.

Format: yyyymmdd

Available for MT 300 and MT 304.

Value Date Specifies the date the FX trade is to be settled as
provided in Field 30V for MT 300, MT 304.

Format: yyyymmdd

Available for MT 300 and MT 304.

Metrics
Metrics available in all monthly/daily wizards (Payments, Trade Finance, and Treasury)

Metric Definition

Amount Received This metric represents the total value received by
your institution, in relation to your message volume
(Transactions Received). The base currency is by
default USD but can be converted.

Amount Sent This metric represents the total value sent by your
institution, in relation to your message volume
(Transactions Sent). The base currency is by default
USD but can be converted.

Original Amount Received This metric represents the total value received by
your institution, in relation to your message volume
(Transactions Received), in their original currency,
that is, not converted to USD.
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Metric Definition

Original Amount Sent This metric represents the total value sent by your
institution, in relation to your message volume
(Transactions Sent), in their original currency, that is,
not converted to USD.

SWIFT Activity Share Amount Received This metric represents your activity share per country,
region, or globally in terms of amount received. The
activity share is the ratio of the total value received
by your institution (Amount received) vs the total
value received by the SWIFT community (Total
SWIFT Amount Received).

SWIFT Activity Share Amount Sent This metric represents your activity share per country,
region, or globally in terms of amount sent. The
activity share is the ratio of the total value sent by
your institution (Amount Sent) vs the total value sent
by the SWIFT community (Total SWIFT Amount
Sent).

SWIFT Activity Share Transactions Received This metric represents your activity share per country,
region, or globally in terms of transactions received.
The activity share is the ratio of the number of
transactions received by your institution
(Transactions received) vs the total number of
transactions received by the SWIFT community (Total
SWIFT transactions received).

SWIFT Activity Share Transactions Sent This metric represents your activity share per country,
region, or globally in terms of transactions sent. The
activity share is the ratio of the number of
transactions sent by your institution (Transactions
Sent) vs the total number of transactions Sent by the
SWIFT community (Total SWIFT Transactions Sent).

Total SWIFT Amount Received This metric represents the total value received by the
SWIFT community (all SWIFT customers) in a
specific country, region, or the global figure, in
relation to the SWIFT community message volume
(Total SWIFT Transactions Received). The base
currency is by default USD but can be converted.

Total SWIFT Amount Sent This metric represents the total value sent by the
SWIFT community (all SWIFT customers) in a
specific country, region, or the global figure, in
relation to the SWIFT community message volume
(Total SWIFT Transactions Sent). The base currency
is by default USD but can be converted.

Total SWIFT Original Amount Received This metric represents the total value received by the
SWIFT community in a specific country, region or
global figures and in relation to message volumes
(Total SWIFT Transactions Received), in their original
currency, i.e. not converted to USD.
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Metric Definition

Total SWIFT Original Amount Sent This metric represents the total value sent by the
SWIFT community in a specific country, region or
global figures and in relation to message volumes
(Total SWIFT Transactions Sent), in their original
currency, i.e. not converted to USD.

Total SWIFT Transactions Received This metric represents the total number of
transactions exchanged in FIN messages received
by the SWIFT community (all SWIFT customers) in a
specific country, region, or the global figures.

Total SWIFT Transactions Sent This metric represents the total number of
transactions exchanged in FIN messages sent by the
SWIFT community (all SWIFT customers) in a
specific country, region, or the global figures.

Transactions Received This metric represents the total number of
transactions exchanged in FIN messages received
by your institution.

Transactions Sent This metric represents the total number of
transactions exchanged in FIN messages sent by
your institution.

Working days This metric represents the number of working days,
for example, per year or per month. This can be used
to calculate daily average volumes.

Additional metrics available in the Payments wizard

Metric Definition

Instructed Amount Received This metric represents the instructed amount
received (field 33B) by your institution. The base
currency is by default USD but can be converted.

Available for MT 103, MT 103 REMIT, and MT 103+.

Instructed Amount Sent This metric represents the instructed amount sent
(field 33B) by your institution. The base currency is
by default USD but can be converted.

Available for MT 103, MT 103 REMIT, and MT 103+.

Total SWIFT Instructed Amount Received This metric represents the total instructed amount
received by the SWIFT community (all SWIFT
customers) in a specific country, region, or the global
figure. The base currency is by default USD but can
be converted.

Available for MT 103, MT 103 REMIT, and MT 103+.
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Metric Definition

Total SWIFT Instructed Amount Sent This metric represents the total instructed amount
sent by the SWIFT community (all SWIFT customers)
in a specific country, region, or the global figure . The
base currency is by default USD but can be
converted.

Available for MT 103, MT 103 REMIT, and MT 103+.

Additional metrics in the Treasury wizard

Metric Definition

Amount Bought Received This metric represents the total value received by
your institution of the currencies that were bought.
The base currency is by default USD but can be
converted. (field 32B).

Available for MT 300, MT 304, MT 305, MT 306, MT
320.

Amount Bought Sent This metric represents the total value sent by your
institution of the currencies that were bought. The
base currency is by default USD but can be
converted. (field 32B)

Available for MT 300, MT 304, MT 305, MT 306, MT
320.

Amount Sold Received This metric represents the total value received by
your institution of the currencies that were sold. The
base currency is by default USD but can be
converted. (field 33B)

Available for MT 300, MT 304, MT 305, MT 306.

Amount Sold Sent This metric represents the total value sent by your
institution of the currencies that were sold. The base
currency is by default USD but can be converted.
(field 33B)

Available for MT 300, MT 304, MT 305, MT 306.

Corrected amount bought received When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Available for MT 300, MT 304, MT 305, MT 306, MT
320.

Corrected amount bought sent When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Available for MT 300, MT 304, MT 305, MT 306, MT
320.
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Metric Definition

Corrected amount sold received When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW). (field 33B)

Available for MT 300, MT 304, MT 305, MT 306.

Corrected amount sold sent When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 33B).

Available for MT 300, MT 304, MT 305, MT 306.

Corrected Original Amount Received This metric represents the total value received by
your institution, in relation to your message volume
(Transactions Received), in their original currency,
that is, not converted to USD.

When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Corrected Original Amount Sent This metric represents the total value sent by your
institution, in relation to your message volume
(Transactions Sent), in their original currency, that is,
not converted to USD.

When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Corrected Pay-Out Amount Received This metric represents the pay-out amount received
(field 33E).

When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Available for MT 306.

Corrected Pay-Out Amount Sent This metric represents the pay-out amount sent (field
33E).

When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Available for MT 306.
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Metric Definition

Corrected Total SWIFT Original Amount Received This metric represents the total value received by the
SWIFT community in a specific country, region or
global figures and in relation to message volumes
(Total SWIFT Transactions Received), in their original
currency, i.e. not converted to USD.

When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Corrected Total SWIFT Original Amount Sent This metric represents the total value sent by the
SWIFT community in a specific country, region or
global figures and in relation to message volumes
(Total SWIFT Transactions Sent), in their original
currency, i.e. not converted to USD.

When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Corrected Total SWIFT Pay-Out Amount Received This metric represents the total pay-out amount
received by the SWIFT community in a specific
country, region or global figures and in relation to
message volume (Total SWIFT Transactions
Received).

When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Corrected Total SWIFT Pay-Out Amount Sent This metric represents the total pay-out amount sent
by the SWIFT community in a specific country, region
or global figures and in relation to message volume
(Total SWIFT Transactions Sent).

When the Function is CANCEL the amount value is
given as a negative value (to enable net aggregation
when combined with records with Function equal to
NEW) (field 32B).

Pay-out amount received This metric represents the pay-out amount received
(field 33E). Available for MT 306.

Pay-out amount sent This metric represents the pay-out amount sent (field
33E). Available for MT 306.

Other metrics are available in the following calculated modes

Metric Definition

Growth current month versus PM Displays the variation between the current and
previous month metrics.
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Metric Definition

Growth YTD versus PYTD Displays the variation between the YTD and PYTD
metrics.

PYTD Displays data form the first month of the previous
reporting year until the latest available of data of the
previous reporting year.

R12 months Displays data for the last 12 months of data
extracted.

YTD Displays data from the first month of the current
reporting year until the last available month of data of
the current reporting year.

Metrics available in the Ranking Reports

Metric Definition

Monthly Amount Received Ranking This metric represents your ranking based on the
monthly amounts received by the SWIFT community.

Monthly Amount Sent Ranking This metric represents your ranking based on the
monthly amounts sent by the SWIFT community.

Monthly Transactions Received Ranking This metric represents your ranking based on the
monthly transactions received by the SWIFT
community.

Monthly Transactions Sent Ranking This metric represents your ranking based on the
monthly transactions sent by the SWIFT community.

Rolling 12 months Amount Received Ranking This metric represents your ranking based on the
amounts received by the SWIFT community during
the last 12 months of data extracted.

Rolling 12 months Amount Sent Ranking This metric represents your ranking based on the
amounts sent by the SWIFT community during the
last 12 months of data extracted.

Rolling 12 months Transactions Received
Ranking

This metric represents your ranking based on the
transactions received by the SWIFT community
during the last 12 months of data extracted.

Rolling 12 months Transactions Sent Ranking This metric represents your ranking based on the
transactions sent by the SWIFT community during
the last 12 months of data extracted.

Watch Banking Analytics Premium 
User Guide

Use Watch Banking Analytics Premium

30 November 2020 45



4.2 Use the Watch Banking Analytics Premium
Reports

4.2.1 View Report Objects
The first time that you get a report, report objects (such as attributes and metrics) may not be
visible. With this procedure, they will be visible the next time you view a report.

Procedure

From the Tools menu, select Report Objects.

Related information

View a Saved Report in the History List on page 52

4.2.2 Change the View of a Report
This function enables you to change the way data is displayed (Grid, Graph, or Grid and Graph).

Procedure

From the Report Home menu, select one of the following views: Grid, Graph, or Grid and Graph.

Related information

View a Saved Report in the History List on page 52

4.2.3 Remove Attributes from a Grid
Before you begin

If the Report Objects panel is not visible, then from the Tools menu, select Report Objects.

Procedure

From your report, drag an attribute from the main panel to the Report Objects panel.

Important If the calculation cannot be correctly done, then the metric shows up as N/A.

Note The result of the drag-and-drop is also visible if you select Graph or Grid and Graph.

Related information

View a Saved Report in the History List on page 52

4.2.4 Move Attributes within a Grid
Procedure

1. Place the cursor on the attribute or metric you want to move.
2. Drag and drop it where you want to place it.

Related information

View a Saved Report in the History List on page 52
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4.2.5 Rename Attributes in a Grid
This function enables you to change the name of an attribute or an attribute component.

Note Name changes are only visible in the templates that you save. SWIFT recommends
that you attach the wizard to the report. For more information, see Save and Share
Reports on page 51.

Procedure

1. Right click the attribute that you want to rename.
2. Select Rename.
3. In the Name field, type the new name of the attribute.
4. Click OK .

Related information

View a Saved Report in the History List on page 52

4.2.6 Use Attribute Forms
This function enables you to decide how you want attribute values to show in your report (that is,
showing both the code and the description, or show only the code or the description).

Procedure

1. In your report result, right click the attribute (header).
2. Select Attribute Forms.
3. Deselect name or description, depending on how you want to show the attribute values.

Example

In the following screenshot, we have removed the message type description and kept the name.
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4.2.7 Show Totals
The Show Totals function enables you to generate totals in the report.

Procedure

From the Data menu, select Show Totals.

Related information

View a Saved Report in the History List on page 52
Edit Totals on page 48

4.2.8 Edit Totals
This function gives you options for calculations, both for subtotals and grand totals, on attributes or
groups of attributes.

Procedure

1. fro the Data menu, select Edit Totals.
The Subtotals Editor window appears.

2. From the Definitions tab, select on or more criteria.
3. Click OK .

Related information

View a Saved Report in the History List on page 52
Show Totals on page 48

4.2.9 Use the Data Filter Function

4.2.9.1 Add a Filter to a Report
Procedure

1. From the Data menu, select Add View Filter Condition.
The View Filter menu appears.

2. From the Filter on drop-down list, select one of the objects of the report.

A window appears, that shows the available attributes that you can filter on.
3. Depending on your selection, you get either or all of the following filter options:

• Qualify

Example: Transactions sent - Greater than - 0
Example: Code - Contains - US33

• Example: # of transactions - Greater than -0
• Example: Code - contains - US33
• Select

You can filter on an attribute In List (the attribute will appear in the filter result) or Not in
List (the attribute is excluded from the filter result).

• Move attributes from Available to Selected
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You can move them using the arrows between the lists.
4. Click Apply .

Note The result is visible in both the grid and the graph views.

Related information

View a Saved Report in the History List on page 52
Use the View Filter Option in a Grid on page 55

4.2.9.2 Remove a Filter From a Report
Procedure

From the View Filter panel, click the cross next to the filter that you want to remove.
The updated report appears.

4.2.9.3 Remove all Filters From a Report
Procedure

From the View Filter panel, click Clear All.

4.2.10 Use the Drill Function
About drilling

Drilling enables you to navigate to different levels or hierarchies of attributes within a report. Drilling
modifies the original report to get more detailed or additional information. You can drill from one
level of information to lower or higher levels of detail. You can also, using the Drill anywhere
option, modify the content of the report.

Drilling down on an existing attribute

Drilling down gives access to data at progressively lower levels within a hierarchy.

Example: from Year to Quarter or to Period (YYYYMM).

Drilling up on an existing attribute

You can broaden the scope of information by drilling up to levels of data higher within a hierarchy.

Example: from Country to Region.

Drill to a new attribute

You can modify the content of the report.

Example: from Year to Country.

4.2.10.1 Drill on Existing Attributes
Procedure

1. From the Data menu, select Drill.

The Drill menu appears and displays all drillable attributes.
2. From the drop-down list next to the attribute that you want to drill on, select the attribute

component that you want to drill to.
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3. Click Apply .

Note If you want to drill on several attributes, then select the attribute component for
each of them separately and click Apply  after each selection.

Tip If you select Keep parent while drilling, then the new report shows both the original
attribute and the attribute component that you have drilled to. This option is a
workaround to the limitation of five attributes that you may select in the Wizard.
However, be careful when using this option as the amount of attributes to be displayed
may decrease the relevance of the report.

Related information

View a Saved Report in the History List on page 52

4.2.10.2 Drill to a New Attribute
Once you have generated a report, you may realize that the output does not match the information
that you need. You can apply the following procedure to modify your criteria.

Procedure

1. Right click the attribute that you want to modify.
2. From the Drill menu, drill to another attribute.

The selected attribute replaces the previous one.

Related information

View a Saved Report in the History List on page 52

4.2.10.3 Cancel a Drill
This procedure explains how to cancel either the last drill you have made, or all drills in a report.

Procedure

1. To cancel the last drill you have made, click the left arrow next to the SWIFT logo.

Alternatively, right click the attribute in the report and select the drill-up icon (for example,
).

2. To cancel all drills in a report, re-select required attributes and metrics (see Add or Remove
Criteria in the Wizard on page 16).

4.2.11 Change the Default Currency
The default currency for the aggregated monthly amounts is USD. You can change the currency
into a currency of your choice.

Procedure

1. From the Banking Analytics Premium page, click one of the three wizards (Payments, Trade
Finance, or Treasury).

2. From the selected wizard, in Please apply the currency to be used for the amount metrics,
double click USD to remove it from the Selected field.

3. From Please apply the currency to be used for the amount metrics, double click a currency
to select it.

The currency you have selected, appears now in the Selected field.
4. Click Run Report .
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4.2.12 Display the Report Details
This function enables you to see the filters that you have applied when customising the information
that you want to see (for example, through drilling).

Procedure

From the Tools menu, select Report Details.

Related information

View a Saved Report in the History List on page 52

4.2.13 Display the Prompt Details
This function enables you to see the selections made in the Wizard.

Procedure

From the Tools menu, select Prompt Details.

Related information

View a Saved Report in the History List on page 52

4.2.14 Save and Share Reports
This function enables you to save the report for future reference and to share it within your
institution.

Procedure

1. From the Report Home menu, select Save as.
2. Browse to the appropriate folder in My Institution Shared Folder.

Tip You can create a new folder using the Create New Folder icon.

3. Add a name for the report and, if appropriate, fill in the Description field.

Tip Check Keep report prompted if you want to save, with the report , the Wizard
selections and its future availability when running the template.

4. Click OK .

Related information

View a Saved Report in the History List on page 52

4.2.15 Save a Report in the History List
This function enables you to add a report in the History List, in the case that you want to work on it
results at a later stage (for example, to filter, to enhance the layout, or to export it). A maximum of
50 reports can be saved in the History List.

Procedure

From the Report Home menu, select Add to History List.

Note You cannot overwrite reports created by other users. To modify such a report, you
must rename it and then save it.

Watch Banking Analytics Premium 
User Guide

Use Watch Banking Analytics Premium

30 November 2020 51



Related information

Run a Report while Using other Functions on page 52

4.2.16 Run a Report while Using other Functions
You can generate a big report and work on other tasks while this report is being generated. To do
this, you need to add the report to the History List.

Tip If the report does not contain a big amount of data, then the Processing Request
window will not appear. You can, however, still add this report to the History List (see
Save a Report in the History List on page 51).

Procedure

1. Run a report using the Wizard.

The Processing request window appears.
2. From the Processing Request window, click Add to my history List.

4.2.17 View a Saved Report in the History List
Procedure

1. From the SWIFT menu icon, select History List.
2. Click the report that you want to view.

Note Reports in the History List are stored with the data they contained when the reports
were initially run. Data is not updated when the reports are re-opened in the History
List. Reports in the History List can be compared to snapshots of the reports.

4.2.18 Export a Report
Procedure

1. From the Report Home menu, select Export and choose the appropriate format that you want.
2. Select the options as required.
3. Click Export .

Related information

View a Saved Report in the History List on page 52

4.2.19 Export a Report to PDF Only
Procedure

1. From the Report Home menu, click the PDF icon.
2. Select the options as required.
3. Click Export .

Related information

View a Saved Report in the History List on page 52
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4.2.20 Print a Report
Procedure

1. From the Report Home menu, click Print.
2. Select the options as required.
3. Click Show Printable Version .

The File Download prompt appears.
4. Click Open  to open the PDF version of the report.
5. Print the document in Acrobat.

Note Two menus are available to print a report: a standard one (explained in this section)
and a PDF-specific menu.

Related information

View a Saved Report in the History List on page 52

4.2.21 Subscribe to a Report
Procedure

1. From a report, click Report home on the top banner.
2. Select Subscribe to.
3. Select History List.

4. From this screen, select the following:

• Select Monthly data load. The data of the previous month will be added automatically to
your report once the data has been published into the tool.

Note The Every day option is only applicable for Watch Banking Analytics Premium
users that have access to daily data.

• Select Send notification to email address.
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You will receive the link to the report on a monthly/daily basis when the data of the previous
month/day is loaded.

4.2.22 Change the Layout of a Graph

4.2.22.1 Change the Graph Style
Procedure

1. Right click the graph and select Format.
2. Go to the General tab.
3. From the Graph Type drop-down list, select the graph style that you want.
4. Click OK .

4.2.22.2 Show or Hide the Legend of the Graph
Procedure

1. Right click the graph and select Format.
2. Go to the Format tab.
3. In the upper part of the window, from the drop-down lists, select Format and Legend.
4. If you do not want a legend to appear for your graph, then clear the Show checkbox.

Note By default, the Show check box is checked.

4.2.22.3 Format the Legend of a Graph
Procedure

1. Right click the graph and select Format.
2. Go to the Format tab.
3. In the upper part of the window, from the drop-down lists, select Format and Legend.
4. Check the Show checkbox if required.
5. Change the format options as required.
6. Click OK .

4.2.22.4 Show or Hide Data Values in a Graph
Procedure

1. From the Graph menu, click the Data Values icon to display the values of the graph.
2. Click the Data Values icon to remove the values of the graph.

4.2.22.5 Set Series by Row or Column in a Graph
Procedure

1. Select the Graph menu.
2. Click either the Series by Row or Series by Column icon, depending on what you want to

highlight.
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4.2.23 Change the Layout of a Grid

4.2.23.1 Display the Grid with Different Font, Colour, and Shape
Procedure

1. Select the Grid menu.
2. From the layout drop-down list, select the autostyle that you want to use.

Note By default, the Corporate view appears on screen.

4.2.23.2 Show Banding in a Grid
This function enables you to alternate shaded and non-shaded rows.

Procedure

1. Select the Grid menu.
2. Click the Banding icon.

4.2.23.3 Use the View Filter Option in a Grid
This function enables you to dynamically filter the information that you see on screen, without
changing the attributes and metrics that are available in the report.

Procedure

1. From the Tools menu, select Page-by Axis.
2. In the Page-By field, type the report object that you would like to filter on (for example, Market).
3. Click OK .
4. If applicable, select the specific component that you would like to filter on (for example, if you

have selected the Market report object, Payments).
5. Click OK .

Related information

Add a Filter to a Report on page 48

4.2.23.4 Swap Rows and Columns in a Grid
Procedure

From the Data menu, select Swap Rows and Columns.

4.2.23.5 Lock Column or Row Headers in a Grid
This function enables you to keep the column and row names visible when scrolling a long report.

Procedure

1. Select the Grid menu.
2. Click either the Lock Columns Headers or the Lock Row Headers icon.
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4.2.23.6 Merge Columns or Rows in a Grid
Procedure

1. Select the Grid menu.
2. Click the Merge Columns Headers or the Merge Row Headers icon.

4.3 Use the Watch Banking Analytics Premium Visual
Dashboards

4.3.1 The Currency Correlation Dossier
Introduction

The objective of this dossier, which focuses on payment messages (MT 103/MT 103 REMIT/MT
103+, and MT 202), is to identify how the major currencies across the world and in specific
corridors are impacting each other. The analysis can be done at corridor level (for example
payments between China and France) and at regional level (for example payments between Asia-
Pacific and North America). The calculation is based on a 12-month period of time.

The currency correlations are presented in 2 ways: in a currency correlation matrix with a specific
colour coding and the underlying data with all details (including the actual correlation).

Currency correlation matrix
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There are 3 correlation categories visible in this matrix:

• Positive correlation (orange)
• Inconclusive
• Negative correlation (blue)

There are 2 metrics shown in the correlations details section being the correlation (on the actual
amounts/volumes) and the correlation proportion (activity shares).

The threshold used to define if there is a relevant correlation between 2 currencies are minimum
+0.65 for positive correlation and -0.65 for negative correlation. Both correlations on the actual
amounts/volumes and the correlation on the activity shares are taken into account for this.

4.3.2 Navigate in a Visual
Tabs

You can navigate from a tab to another of a visual, based on the information that you are searching
for.

Pages

The data can be split over several panels on the same tab (for example, Transactions sent on
page 1 and Transactions received on page 2). In that case, only page 1 of 2 is displayed. You can
navigate through the pages using the displayed on the right-hand side of the visual.

Display data on the map

Position the mouse over the map to display additional data.

4.3.3 Export a Visual to PDF or Excel
This procedure explains how to export the underlying data of the visual, not the visual itself. To
export the visual itself, use a standard capturing tool.

Procedure

1. Position the mouse over the map or other visual.
2. On the top left-hand side of the visual, click the PDF or Excel icon.

The file download window appears.
3. Select options as required.
4. Click OK .

4.3.4 Save a SWIFT Template Report or a Visual to the Shared
Reports
The Reports and Visuals are read-only. This procedure applies if you want to amend a report or
visual and keep it for future reference or share it within your institution.

Procedure

1. From the Visual Dahsboards, right click the Report or Visual that you want to copy.
2. From the drop-down menu, select Shared Reports .
3. Select My Institution Shared Folder .
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4. Select the adequate sub-folder as required.
5. Click OK .

4.3.5 Display Data Information in a Visual
Use this function to display more detailed information in a visual.

Procedure

Mouse over the attribute/element for which you would like to have more information about.

Information (figures) appears on screen.

4.3.6 Add a SWIFT Template Report or a Visual to the History
List
This function enables you to add a report or visual from the in the History List. This can be useful if
you want to use the report or visual at a later stage or if the visual is taking a lot of time to upload.

Procedure

Click the Add to History List icon.

4.3.7 Maximise or Minimise a Visual
Procedure

1. Click the  button displayed on the top right of each visual to maximise the visual or the 
button to minimise the visual.

2. For graphs/visuals that are too small to display the full legend information, click the  button
before displaying the legend.
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Appendix A  List of New Aggregated Payload
Information Compared to Watch Banking
Analytics

Payments

The new aggregated payload information that is available in Watch Banking Analytics Premium is
retrieved from the following fields:

• MT 101 Request for Transfer

- field 52A (Account Servicing Institution)
- field 57A (Account with Institution)

• MT 103 Single Customer Credit Transfer Core

- field 23E (Instruction code)
- field 52A (Ordering Institution)
- field 53A (Sender correspondent)
- field 54A (Receiver correspondent)
- field 56A (Intermediary institution)
- field 57A (Account with Institution)
- field 33B (Currency/instructed amount)
- field 70 (Remittance information)
- field 71A (Details of Charges)
- field 72 (Sender to Receiver Information)

• MT 103+ Single Customer Credit Transfer STP: same as for MT 103
• MT 103 REMIT Single Customer Credit Transfer Remit: same as for MT 103
• MT 202 General Financial Institution Transfer

- fields 52A and 58A (Ordering and Beneficiary Institution)
• MT 202 COV General Financial Institution Transfer: same as for MT 202
• MT 205 Financial Institution Transfer Execution

- fields 52A and 57A (Ordering and Beneficiary Institution)
• MT 205 COV Financial Institution Transfer Execution: same as for MT 205
• MT 940

- field 60A (only currency and option)
• MT 950

- field 60A (only currency and option)

Value buckets are also available in Watch Banking Analytics Premium for the following message
types: MT 101, MT 103, MT 103+, MT 103 REMIT, MT 202, MT 202 COV, MT 205, and MT 205
COV).
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Treasury

Value buckets are available in Watch Banking Analytics Premium for all message types for which
we extract currency and value information (MT 300, MT 304, MT 305, MT 306 and MT 320).

• MT 300 Foreign Exchange Confirmation

- field 22A (Transaction type)
- field 22U (Transaction type B)
- field 17F (NDF indicator)
- field 17O (NDF opening)
- field 72 (Settlement country)
- field 30V (Value date)
- field 30T (Trade date)
- field 32B (Currency, Amount bought)
- field 33B (Currency, Amount sold)

• MT 304 Advice/Instruction of a Third Party Deal

- field 22A (Transaction type)
- field 22U (Transaction type B)
- field 30V (Value date)
- field 30T (Trade date)
- field 32B (Currency, Amount bought)
- field 33B (Currency, Amount sold)

• MT 305 Foreign Currency Option Confirmation

- field 22A (Transaction type)
- field 22U (Transaction type B)
- field 17F (NDF indicator)
- field 22A (Transaction type)
- field 22U (Transaction type B)
- field 32B (Currency, Amount bought)
- field 33B (Currency, Amount sold)

• MT 306 Foreign Currency Option Confirmation

- field 22A (Transaction type)
- field 94A (Transaction type B)
- field 32B (Currency, Amount bought)
- field 33B (Currency, Amount sold)
- ield 33E (Currency, Amount pay-out)

• MT 320 Fixed Loan/Deposit Confirmation

- field 22A (Transaction type)
- field 32B (Currency, Amount bought)
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Trade Finance

The new payload information that is available in Watch Banking Analytics Premium are as follows:

• MT 700 Issue of a Documentary Credit

- field 31D (Date of expiry) minus field 31C (Date of Issue) organised by length buckets
- field 41A (Available With ... By ...)
- field 49 (Confirmation Instructions)

• MT 707 Amendment to a Documentary Credit

- field 31D (New date of expiry) minus field 31C (Date of Issue) organised by length buckets
• MT 710 Advice of a Third Bank's Documentary Credit

- field 40B (Form of Documentary Credit)
- field 41A (Available With ... By ...)
- field 51A (Account Servicing Institution)
- field 49 (Confirmation Instructions)

• MT 720 Transfer of a Documentary Credit

- field 40B (Form of Documentary Credit)
- field 49 (Confirmation Instructions)

• MT 740 Authorisation to Reimburse

- field 41A (Available With ... By ...)
• MT 742 Reimbursement Claim

- field 52A (Issuing Bank)

Value buckets are also available in Watch Banking Analytics Premium for the following message
types: MT 400, MT 700, MT 707, MT 710, and MT 740.
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Legal Notices
Copyright

SWIFT © 2020. All rights reserved.

Restricted Distribution

Do not distribute this publication outside your organisation unless your subscription or order
expressly grants you that right, in which case ensure you comply with any other applicable
conditions.

Disclaimer

The information in this publication may change from time to time. You must always refer to the
latest available version.

Translations

The English version of SWIFT documentation is the only official and binding version.

Trademarks

SWIFT is the trade name of S.W.I.F.T. SC. The following are registered trademarks of SWIFT:
3SKey, Innotribe, MyStandards, Sibos, SWIFT, SWIFTNet, SWIFT Institute, the Standards Forum
logo, the SWIFT logo, SWIFT gpi with logo, the SWIFT gpi logo, and UETR. Other product, service,
or company names in this publication are trade names, trademarks, or registered trademarks of
their respective owners.
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